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Introduction 

An important driver for the Regional Coastal Monitoring Programmes is that all data collected and 

made freely available should be quality-controlled in a thorough and consistent manner, to ensure 

that the data meets the Specification, with the result that the data can be used subsequently with 

confidence for a wide variety of coastal engineering and management tasks. 

This document describes the procedures used by the National Network of Regional Coastal Monitoring 

Programmes to quality-control lidar data, and can be used at three different levels: 

 A summary of QC tests, for those users who just want a brief overview of the generic quality 

control 

 Details of the quality control process including: 

o Workflow process i.e. the checks to be made and the most suitable order in which they 

are carried out. This section includes mandatory checks plus some optional checks 

depending on the landscape captured e.g. high cliffs, or on the deliverables in the Brief.  

o The methods used to carry out the checks, including the thresholds used.  This section 

includes clear examples of what is and what is not acceptable. 

 Sample procedures for undertaking the checks.  Those undertaking quality control may use 

any software or methods they wish, providing the QC standards are met.  However, since most 

of the data quality control tests are expected to be done in a GIS, an example of a suitable 

procedure using ArcGIS (Standard licence, Spatial Analyst and 3D Analyst extensions) is given 

(Appendix B).  The methods given here should also work in other GIS software1.   

Appendix A is a diagram summarising the quality control workflow 

Appendix B provides a procedure for ArcMap which can be used to complete the QC checks 

Appendix C provides a sample template to record the QC process  

Summary of QC tests 

The quality control tests fall broadly into two categories: 

 Data quality 

o Reached required depth at seaward limit 

o Water removal 

o Gaps 

o No striping/pocking 

o Removal of spikes e.g. flocks of birds, pylon cables 

o Polygon coverage 

o Structures included in DSM, excluded in DTM 

o Vertical accuracy 

o Flight lines (optional) 

o Point density (optional) 

o Profiles (optional) 

  

                                                           
 

1 Point clouds cannot be loaded in QGIS but other software can be used to view e.g. Cloudcompare. 
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 Data management (final deliverables) 

o Correct number of tiles received in all required formats e.g. *.asc and *.txt 

o Correct file names  

o Correct file formatting 

o No duplicated filenames 

o All deliverables delivered 

Workflow for data quality checks 

Viewing scale 
The scale at which the lidar should be viewed for quality control depends on the resolution of the 

data. For example, viewing 1 m resolution data at a scale of 1:2400 means that 1 cm represents 24 

pixels i.e. 24 metres, which leaves too much margin for error when digitising. Accordingly, for 1 m 

resolution lidar, the recommended scale for QC is 1:2000 when going through the tiles and 1:1500 for 

editing.  

Datasets 
- Elevation rasters as mosaics or 1 km tiles 

- LAS point cloud - exclude Tie lines and use last returns only 

- Aerial photography/base maps2 

- Watermask (if provided) 

- Tile index shapefile 

Derived datasets 
- Hillshade raster 

- MLWS contours 

- Intensity raster (can be created from intensity values of LAS Point cloud) 

Step 0  Copy data 

Copy the data for QC to your local machine or to a Hard Drive. Avoid working from a network drive as 

this can be slow and progress could be lost if the connection drops out. 

Step 1  Filtered, unfiltered or both? 

Lidar data can be delivered as unfiltered and/or filtered rasters (as defined by the Brief). The route 

through the QC checks is slightly different depending on the deliverables. 

The unfiltered Digital Surface Model (DSM) is created from the last return of the lidar pulses and 

contains trees, buildings, structures etc. The filtered Digital Terrain Model (DTM) is a “bare-earth” 

dataset where buildings, cars, trees etc. have been removed (filtered) from the data. 

Data may be delivered as DSM, DTM or both. The only difference in terms of quality control is the 

presence or absence of structures (see below). Unfiltered and filtered rasters are created from the 

same point cloud so if both types are delivered, start by carrying out all checks on the unfiltered data. 

Any issues concerning water removal, spikes, gaps, polygon coverage, and seaward limit will be the 

                                                           
 

2 Use aerial photography as an aid only, especially when it was collected at a different date from the 

lidar data. If the aerial photography is on the coastalmonitoring.org website, it can be accessed as a 

WMS layer in Arc or in QGIS. 
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same for the filtered data. Then load the filtered data (mosaic and hillshade) and check if structures 

have been removed in accordance with the Brief. Clearly, if only one type of data is delivered, all data 

quality checks are carried out on the delivered datatype. 

Use Appendix A to see which QC route to follow. 

Step 2 Watermask and elevation mosaic 

The easiest way to QC is to use a watermask polygon, together with a mosaic of the elevation rasters 

provided by the Contractor. The watermask is a shapefile indicating where water will be removed from 

the data. Everything outside the watermask polygon or in gaps in it will be removed from the final 

dataset.  

If watermasks are provided by the Contractor, make a copy and edit them directly for issues 

concerning water removal and seaward limit. If a dataset was flown on multiple dates, multiple 

elevation mosaics and watermasks may have been delivered by the Contractor. In this case, create a 

single raster from the delivered elevation mosaics. If the preliminary data is delivered without 

watermasks, create a mosaic from the OS 1 km tiles (see Appendix A and B). 

If it is apparent at this stage that the data has been delivered in millimetres or integers, halt QC and 

ask the Contractor to re-deliver the data in metres. 

Step 3 Create derived datasets and load other data 

 Create a hillshade raster and Mean Low Water Springs (MLWS) contours from the mosaic, and 

load them in the GIS  

 Create LAS datasets and intensity rasters and add them to the map   

 Add other supporting layers to the map (e.g. survey polygon, index shapefile, aerial 

photography). Display any polygon datasets as an outline only  

 Label the index shapefile with the tile name  

 Set symbologies as desired and order the layers in the table of contents (see Appendix B) 

 Check that the tiles in the index file are named with the correct OS tile name. Check a few tiles 

of the index polygon against the OSGB grid information layer on the website or a shapefile 

with the 1k OSGB tiles to verify this 

Step 4 Vertical accuracy check  

Check that the vertical accuracy of the data is acceptable by comparing samples against areas that 

have been surveyed on the ground (minimum accuracy in processed data should be +/- 0.10m RMSE). 

If there is more difference than is acceptable between the surveys, halt QC and inform the Contractor 

before proceeding with the rest of the QC. Checking vertical accuracy might be impractical in areas 

where there are no suitable reference areas to check the lidar data against – e.g. extensive dunes or 

soft cliffs – or where no data is available to compare the lidar against. 

Step 5 Optional additional checks 

Flight lines  

If the frontage has cliffs, dunes or other features that might cause shadowing, check the flight paths 

were appropriate to capture them. These landforms usually require a minimum of 2 flight lines, one 

to seaward and one to landward of the feature. Where only one flight line is used, it should be seaward 

of Mean High Water (MHW). Load the “smoothed best estimate of trajectory” shapefile (SBET) 

(containing time, original position and attitude data, as captured during the flight in its attribute table) 
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and assess if they are appropriate or compare them to the runs proposed by the Contractor before 

flying. Record the result in the spreadsheet. 

Point density 

Depending on the desired output resolution, the point cloud data should be collected at a minimum 

density of 1 point per m2 for an output of 1x1m cells and 4 points per m2 for a grid with a cell size of 

0.5x0.5m. In ArcMap you can use the LAS Point Statistics as Raster tool to create a raster from a LAS 

dataset that describes the number of returns per cell. The method should be pulse_count and the 

sampling value (= cell size of the output grid) should be about 4 times the size of the resolution of the 

delivered data (so 4 for a 1m resolution grid, 2 for a 0.5m resolution grid) – this reduces the processing 

time and avoids creating a huge dataset. The value of each cell in the output grid is the number of LAS 

points recorded for that grid. Check the statistics in the “source” tab of the properties of the raster. 

Divide the mean by the value you put in the sampling value in the tool. The result is the point density. 

So a mean value of >16 is good for a lidar grid with a 1m resolution. Record the result in the 

spreadsheet. 

Profiles3 

If profiles are part of the deliverables, check for the following: 

 the profiles coincide with profile line shapefiles  

 profiles start at the required starting point  

 profiles reach the required depth and that they cover the raster to its seaward extent  

 there are no points where there is no lidar data available e.g. through runnels 

 the data file contains the correct columns of data   

Step 6  Error polygons and watermask editing 

The quickest way to highlight any issues is to generate a polygon shapefile indicating the type of issue 

e.g. gap, spike, water removal (see Appendix B for how to create a shapefile with a dropdown box to 

pick QC issues). Add polygons to the shapefile as you encounter errors, and if watermasks are 

delivered edit the watermask copies for any seaward limit and water removal-related issues (Appendix 

B). Be careful when editing watermasks: it is very easy to accidentally “drag” part of the mask slightly. 

The contractor uses the amended watermask to create the final dataset so if it’s “dragged” slightly, 

the polygon won’t be covered properly. 

If both filtered and unfiltered data are delivered, check the unfiltered data first. Then load the filtered 

data and check it for issues with structure removal only. All other issues should be the same. 

Step 7 Record issues 

 Use a quality control spreadsheet e.g. Lidar_QC_YYYY_YYYY.xlsx (where YYYY indicates the 

winter flying season the surveys were carried out) to keep track of general issues with the 

data (Appendix C, Table 1) 

 Export the index shapefile as an excel file (see Appendix B) and copy the OS tile column to a 

separate tab in the spreadsheet (named with the Work Package name). Use this list of all the 

                                                           
 

3 Note that profile checks should be done only after all other quality issues have been addressed, to 
ensure that they are generated from quality-controlled data. Consider discussing with the Contractor 
to delay production of profiles until the data quality has been accepted.  
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tiles in the Work Package as a guide when going through the data (sort it alphabetically first). 

This makes sure that no tiles are skipped and helps to keep track when QC spans multiple 

days. Use this worksheet as well to highlight any issues with individual tiles (Appendix C, Table 

2).  

 Send both the edited watermask and the QC shapefile to the Contractor (see Appendix B on 

how to export the QC shapefile from the geodatabase to a shapefile) 

Workflow for data management checks (on final deliverables) 

QC issues addressed 

 Load the corrected data in the GIS and check that the issues that have been sent to the 

Contractor have been addressed.  

 Use the QC shapefile as a guide and make a note in the “Fixed” column of the Work Package 

worksheet whether the highlighted issues have been rectified.  

 Record any comments briefly on the corrections in the Master worksheet as well. 

Overlapping polygon/duplicate tile name checks 

 Load the final delivered index shapefile in Arc and label it with the file name 

 Check that there are no tiles labelled twice or more (indicating that multiple files have been 

delivered for the same OS tile), see page 13 for exceptions and further details 

General checks 
Check that metadata, report, survey polygon and flight index are correct and present, as well as any 

other deliverables requested in the Brief.  

Check that filenames for data delivered in polygons (*.asc mosaics) are based on the Work Package 

polygon number, survey date and data type (see Appendix C, Table 1). It is important to remember 

that these mosaics are processed but without removing the water, to allow users to modify the data 

themselves. If a final water-free DSM and/or DTM mosaic is required, it should be created from the 

1k tiles after the survey is accepted. 

XYZ files 

 Check that the same number of *.asc and *.txt files is delivered and that they have been 

named correctly, using the correct file extension 

 Check file names and extensions and make sure all data is dated with the same correct date 

(see further for detailed description)  

Completion of quality control 

Acceptance of survey 

 Inform the Contractor that the survey has been accepted and fill out the “Survey Accepted” 

and “Raster Created” columns in the spreadsheet 

 When the survey is accepted, delete any temporary QC files that are not needed anymore 

 Create water-free DSM and DTM mosaics from the final 1 km DSM and/or DTM tiles and save 

in a MOSAICS folder in the root folder of each Work Package  

 Create hillshade rasters from the final mosaics and save in the same folder 

Upload data to www.coastalmonitoring.org website 
Usually only one report covering the whole area flown is delivered after all the Work Packages have 

been QC’d. Make copies of the final report and put a copy in each work package folder, since the data 

http://www.coastalmonitoring.org/
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will be uploaded to the website in survey polygons. Change the report name to match each work 

package name and flying date (use the latest flying date if multiple dates were used to fly a polygon). 

Make sure the report name in the metadata form matches the names of the report copies. 

Upload data to the FTP for subsequent uploading to the website by CCO. Upload work packages in 

separate folders and only include unfiltered and filtered tiles (XYZ and ASCII), metadata, report and 

profiles (if delivered and if they need to be uploaded to the website) and let CCO know when finished. 

Fill out the “Loaded to FTP for Website” column in the QC spreadsheet. 

Methods 

1. Data quality 

Not integer 
When first loading the elevation data, check that it is delivered as floating point in metres, not as mm 

and integers. Do this by looking at the “High” and “Low” values of the mosaic raster in the table of 

contents in ArcMap. If they are decimal numbers that look like a sensible range of values for the area, 

they are ok. If they are in mm, the values are usually in the thousands. 

Fill out the spreadsheet. 

Full polygon coverage 
When going through each tile, make sure that the collected data covers the entire polygon on the 

landward side. If it is not fully covered, add a polygon to the QC shapefile and fill out the spreadsheet. 

Note that polygon coverage issues are different from “gaps”; polygon coverage issues are areas where 

no data was collected over part of the polygon. Gaps are parts of the dataset where data was collected, 

but not included in the final dataset. 

 

Figure 1: Polygon not completely covered 

Seaward limit reached 
Check that the data reaches the specified seaward limit by forcing MLWS contours (in Ordnance 

Datum) through the raster (see Appendix B). For locations in between tidal stations, estimate or 

interpolate the MLWS level based on the nearest tidal stations. If the data has reached the required 

depth, an unbroken contour should be produced. When using watermasks, the contour should fall 

completely within the watermask boundary. Amend the watermask if it doesn’t. 
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If the data fails to reach depth, check that flights have been conducted at appropriate times on 

appropriate tides. If flights were carried out on an appropriate tide, make a note on the Master 

spreadsheet that the seaward limit wasn’t reached but that the flight was carried out in an appropriate 

window. Where tidal stations are far up tidal rivers and in harbours, MLWS may not be reached, even 

though the flight was carried out within an appropriate tidal window. 

If MLWS is not reached, make sure that as much dry land as possible is included in the watermask/in 

the data. If there is more dry land available outside the watermask, amend it to include the dry land 

(Figure 2). When not using watermasks, use the water-containing mosaics that are delivered with the 

preliminary data to check if more dry land is available and add the missing area to the QC shapefile. 

Use the symbology settings of the elevation raster, the LAS point cloud and the Intensity raster to help 

decide where the water line is (see Appendix B on how to create these datasets, and the next section 

on water removal for examples). 

 

Figure 2: Contours showing there is dry land available that wasn't delivered in the 1k tiles. 

Figure 2 shows an example of seaward limit checks of preliminary data that wasn’t delivered with 

watermasks. The contours were drawn from the water-containing mosaic and overlaid on the mosaic 

that was created from the 1 km tiles. This showed that there was a lot more dry land available than 

was delivered. 

If watermasks have been delivered, amend them as required. If working without watermasks, add a 

polygon that covers the area that needs to be included to the QC shapefile. 

Water removal 
On the open coast there should be no areas containing tidal water included in the watermask polygon, 

although small patches of standing water e.g. in runnels or beach creeks are acceptable, as is estuarine 

water. Large water bodies like ponds, lakes and lagoons should be excluded from the watermask as 

well as water areas that are ≥10 m in width. Swimming pools, small ponds and narrow creeks and 

rivers may be left in.  
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Use the Intensity rasters to help identify areas with water (exclude tie lines, and only use last return). 

The intensity value is an indication of the reflectivity of the surface and can make the difference 

between different types of surfaces and between land and water clearer. It is a relative value so will 

be different from flight to flight. 

“Patterns” in the elevation raster can also indicate water (waves are sometimes visible in the data). 

Play around with the colour ramp and stretch settings to maximise information from the data (see 

Appendix B). You can also use the closest available aerial photography but be careful when using aerial 

photography from a different flying date/time when looking at water courses in mobile sediment.  

Contours can help to show up water as well (see Appendix B on how to draw quick contours). 

 

Figure 3: How to recognise water in the raster 

In Figure 3, the turquoise blobs in the red ovals on the left are probably foam at the top of the waves; 

the dashed lines indicate the crests of incoming waves. The image on the right shows how the pattern 

of the elevation raster can give an indication of which areas are water or land. In this case the red 

polygon has the same colour/pattern as the more seaward areas so it is probably water. 

 

Figure 4: Waves in the elevation raster and the intensity raster 

Figure 4 also gives an example of what waves look like in lidar. In this case they have not been removed 

from the watermask (yellow line). The black and white image below shows the Intensity raster for the 
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same area. The original watermask follows the lighter shade of intensity but frothy water can give this 

return as well. There are some darker lines visible cutting through the light area, these take the shape 

of the wave crests (blue dashed lines). 

 

Figure 5: Elevation raster on the left, intensity on the right 

Figure 5 shows clearly how the intensity raster displays different surface types. The islands in the top 

left corner are defined much clearer in the intensity raster and the boundary between the beach and 

the water in the bottom right corner is very clear in the intensity raster. 

 

Figure 6: Contour behaviour on still water and land 

Figure 6 illustrates how contours can make clear where land ends and water begins. Contours also 

help clarifying the topography of areas that appear flat or slope very gently. On dry sloping land the 

contours are clear defined lines. Where it becomes flatter, they might appear a little bit messy, but it 

is still possible to follow a “line”. On still water, they become very dappled and can cover the entire 

surface (yellow and orange from the middle to the bottom right). 
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Figure 7: Histogram equalize stretch on the left, percent clip stretch on the right. Waterline is 
indicated by the black line 

Figure 7 shows another example of how the symbology settings of the elevation raster can highlight 

the water/land boundary. 

Amend the watermask or add a polygon to the QC shapefile where water needs removing. Where 

water needs to be removed from a large pond or lake a “donut” hole might have to be created in the 

watermask (see Appendix B). 

Gaps 
Check that there are no gaps in the raster where data is missing or has been accidentally filtered out. 

Gaps are parts of the dataset where data was collected, but not included in the final dataset. Use the 

LAS point cloud to check if data points are available. Make sure to use only the last return points (see 

Appendix B). If there are no points in a gap, it should not be flagged. The point clouds are quite large 

to load, so you can just check the Intensity raster as an initial check. The Intensity raster is made from 

the LAS points, so if there is a gap in the Intensity raster, it means that there were no data points 

available and the gap is a real gap. If there is no gap in the intensity raster, check the point cloud. 

When using the Intensity raster or point cloud, make sure you use the one that has the same date as 

the tile you are checking. Sometimes two flying dates have covered the same area, but only the point 

cloud of the date in the tile name will have been used to make the elevation raster. 

Explanation for acceptable gaps: 

 Last return data is used to generate the output and where there is an absence of a recorded 

last return pulse(s) on a bridge/structure (i.e. the first returns hit the bridge but the last return 

was from the terrain below) there will be gaps. 

 Where very dark/black material is present on the roof, laser pulse energy can be absorbed by 

the surface and not received back by the sensor resulting in no data. Where the area of no 

data is beyond the interpolation threshold for the surface there will be a data gap. 
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 There can occasionally be gaps on along cliffs caused by shadowing of the cliff face and the 

foot of the cliff as seen by one swathe and the overlap of the neighbouring swathe not 

covering that area. This is especially the case where the cliff is towards the centre of the 

landward swathe. There can also be gaps in the dataset due to shadowing of the ground by 

another structure, especially in dense urban areas with high buildings and narrow streets.  

 Cliff overhangs may also cause issues as the grid cell can only contain one Z value i.e. you 

cannot have the top of the cliff and the bottom of the cliff represented in the same cell. 

Add a polygon to the QC shapefile where there are gaps in the data. 

Data Spikes 
Check for spikes in the raster, spurious points caused by flying birds, power cables etc. (Figure 9). 

Points from people on the beach, wrecks and boats resting on dry land, vehicles, large pylons… are all 

acceptable and should not be recorded as spikes. Where the laser passes through glass roofs and Velux 

windows the signal can be reflected off surfaces inside the building before returning to the sensor, 

making the elevation of the point lower than the surrounding points, resulting in messy buildings. This 

does not need correcting (Figure 8). 

Make sure that spikes will show up in the symbology settings you are using for the raster (if the top 

and bottom 5 per cent values of the dataset are set to be the same colour, spikes on the lowest 

beaches and highest cliffs might not be visible.  

Add a polygon for any spikes to the QC shapefile. 

 

 

 

Data stripes/pocking 
These do not occur very often but they may appear in the data where there have been changes in 

surface elevation between flight lines within a tidal window – these are within-system QC tolerances 

and details of data checks will be provided in the end of project report (Figure 10, Figure 11). Where 

these are due to calibration error beyond the system specification they should be addressed in data 

processing.  

Check also that structures in the sea are georeferenced properly. Use the aerial photography to check 

if they are in the correct place, or use an Ordnance Survey basemap (OS open data is available in 

ArcGIS as a standard basemap). 

Figure 9 (left): Spikes from power cables 

Figure 8 (above): Reflected signals in buildings resulting 
in spikes 
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Figure 10: examples of stripes that are within QC tolerances 

 

Figure 11: Harbour pier not aligned with OS basemap, one of the flight lines was not georeferenced 

correctly 

Add a polygon to the QC shapefile for any striping issues. It might be worth sending a screenshot to 

the contractor when sending the QC shapefile. 

Structures 
DSM (unfiltered data) - the digital surface model should include all features and structures that are 

attached to the ground (bridges, piers, trees, wrecks, boats resting on dry land, houses, vehicles, large 

pylons, people wandering around). Check that such structures haven’t been removed from the 

dataset. Add any missing structures to the QC shapefile (Structures Unfiltered). Floating pontoons, 

jetties and boats should be removed. 

DTM (filtered data) - the digital terrain model has structures and features removed (“filtered”) from 

the data so check that structures have been removed as detailed in the Brief. Beach structures such 
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as groynes, breakwaters and harbour walls might have to be included while piers, beach huts or 

ephemeral features might have to be filtered out. Add a polygon for structures that need removing to 

the QC shapefile (Structures Filtered). 

2. Final Deliverables – Quality checks 

Overlapping polygon/duplicated file names 
Duplicate file names should be avoided at all cost as these cause problems when uploading data to 

the website. Duplicate file names can occur where work packages or subpolygon boundaries meet. 

Therefore it is best practice to choose adjoining work packages so that boundaries coincide with OS 

tile boundaries where possible.  

Where work packages consist of several subpolygons whose boundaries go through an OS tile over 

land, a single tile should be produced using the later survey date in the tile name. Where the 

subpolygon boundary goes through a harbour or a river or a similar water feature, multiple rasters for 

the same OS tile are allowed if the subpolygons were flown more than a week apart, as long as they 

have different flying dates in their file names. If they were flown on the same day or only a few days 

apart, a single tile should be delivered using the latest flying date in the tile name. 

Work package boundaries as decided by the client should be respected, even if they are not on an OS 

tile boundary. However if two adjoining work packages are flown on the same day, or only a few days 

apart, the tile on the boundary should be delivered as a single tile in one of the two work packages. 

In the cases where delivery of multiple tiles from different flying dates for the same OS tile is allowed 

there should be no data overlap between the tiles. Each tile should cover a different section of the OS 

tile. 

 

Figure 12: 2 tiles delivered instead of 1 OS tile. In this case 1 tiles should be delivered in the final 
dataset, named TR3865_20140302lidaru.asc. It would be better to change to polygon boundary to 

coincide with the OS tile boundary 
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Figure 13: Tile SZ0387 was covered on different flying dates. The boundary goes between Brownsea 
Island on the left and Sandbanks on the right. Tile SZ0387_20151128lidaru.asc only contains the 

right part of the tile, tile SZ0387_20160211 only contains the left part of the tile. This is OK. 

Profile checks (optional) 
Profiles are delivered as points in text files. Check that 7 columns of data and 1 header row have been 

delivered. 

Example: 

Easting  Northing Elevation_OD Chainage FC Profile  Reg_ID 

484955.63 92411.06 0.76  171.00  ZZ CHI166  5a00001 

484955.01 92410.27 -0.790  172.00  ZZ CHI166  5a00001 

484954.40 92409.48 -0.790  163.00  ZZ CHI167  5a00002 

Profile is the local name of the profile, Reg_ID is the Regional line name. FC refers to the Feature Code 

(for sediment type), which is ‘ZZ’ for all lidar surveys, since sediment type is not derived. 

Load the delivered profile points in ArcMap and convert them to shapefiles (see Appendix B). Load a 

shapefile of the profile lines. Label the points and the profile lines with the local profile line name and 

make sure they match. Then label them with the regional profile name and make sure they match 

again. Check the points are on top of the lines and start in the correct position. 

Use a mosaic of the final delivered tiles and check that the points extend to the full seaward extent of 

the raster, but not beyond the waterline.  
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Make also sure no points have been delivered where no data was recorded. Convert the raster to a 

polygon shapefile and use a “select by location” approach to identify any points that are not in the 

polygon (See Appendix B). Feed back to the contractor if any errors are encountered (make a note of 

the profile name, Survey Unit, Easting, Northing and include a screenshot). 

3. Final Deliverables – Data Management checks 

Data labelling (optional) 
The medium (CD/DVD) on which the data is delivered should be labelled as follows: 

Label: 

 LiDAR 

 Survey area 

 Polygon ID 

 YYYYMMDD 

 Disk number 

 Contractor 

Data labelling does not apply to data delivered on hard drives or through FTP software. 

Data file names 
The data filenames must be in the correct format and case so that it can be loaded to the website. OS 

tiles and _SANDS should be in uppercase, file extensions and the type of data (u or f) in lowercase. 

1k tiles: OSOSOS_YYYYMMDDlidarxx 

where: OSOSOS is the Ordnance Survey 1km Tile Name – 6 digits (uppercase) 

 YYYY is the year of survey 

 MM is the month of survey 

 DD is the day of survey 

 lidarxx is the type of data (lowercase) - replace xx with u for DSM and f for DTM 

Make sure the correct tile name is used. 

Examples: SX6639_20070331lidaru.asc 

  SX6639_20070331lidarf.txt 

Profiles: CCUUU_YYYYMMDDlidarxxp.txt 

where:  C is the Coastal Process Sub-Cell (2 digits) e.g. 6a (lowercase) 

 UUU is the Survey Unit (variable number of digits) e.g. SU16 

 YYYY is the year of survey (4 digits) 

 MM is the month of the survey (2 digits) 

 DD is the day of the survey (2 digits) 

 lidarxx is the type of data (lowercase) – replace xx with u for DSM and f for DTM 

SANDS files should be named as above with _SANDS inserted following lidarxxp 

Examples: 7eMU15-4_20090210lidarup.txt 

  7eMU15-4_20090210lidarfp_SANDS.txt 

Data delivered in polygons 

Data delivered in polygons (*.asc, *txt mosaic) should be based on the Work Package polygon number, 

survey date and data type: 

  WPNN_PP_YYYYMMDD*.* 
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where: WP is the Work Package name (variable number of characters/digits) 

 PP is the polygon number (2 digits) 

Examples: LSW01_01_20111027lidarf.asc 
  LSW02_04_20111027lidaru.txt 

Point clouds 

The las point cloud names should be based on the Work Package polygon number, survey date and 

data type, with addition of Line number (L*) or Tie Line number (T*) as appropriate: 

Examples: LSE01_01_20111027_L1lidaru.las 

                             LSE05_04_20121202_T3lidaru.las 

Check all data is dated with the same date and that the date is correct. The correct date is the date 

the survey was completed. This should be supplied in the report. If a work package was flown over 2 

or 3 contiguous days, the date used for the 1km tile names should be the last date of the survey. 

Where tiles within a survey area were collected more than a week apart, files should be named with 

separate dates. 

Metadata 
Check that the metadata form is present and named and dated correctly. 

                          Meta_lidar_WPNN_YYYYMMDD 

Where:  WP is the Work Package name (variable number of characters/digits)  
  YYYY is the year of survey (4 digits) 
  MM is the month of the survey (2 digits) 
  DD is the day of the survey (2 digits) 

Check that the relevant fields are filled in and that the start and end dates and the name of the survey 
report are correct. The metadata form should be named with the end date of the survey. 

Example Metadata Form 
General Information   

Name of LIDAR instruments manufacturer: OPTECH 

Instrument model: GEMINI 

Average flight height (metres): 700mAGL (approximate) 

Swath width (metres): 800.00 

Grid size (metres) 0.50 

Units of elevation reading for ASCII grid file: mAOD 

Units of elevation reading for text file: mAOD 

Start Date (dd/mm/yyyy): 17/09/2009 

End Date (dd/mm/yyyy): 17/09/2009 

Distance of elevation readings along profile (metres): N/A 

Quality Information   

Estimated accuracy of dataset: positional accuracy +/-40cm 

  elevational accuracy +/-15cm 

Explanation of accuracy estimate:   

Metadata Information   

Data has been collected by: Environment Agency - Geomatics Group 

Comments: Contact Alison Matthews 

 

  



18 
 

Survey Report 
Check the survey report is present and is named in the correct format and case and dated correctly.  

 Report_lidar_SurveyAreaNameWPNN_YYYYMMDD 

where:  WP is the Work Package name (variable number of characters/digits) 
  YYYY is the year of survey (4 digits) 
  MM is the month of the survey (2 digits) 
  DD is the day of the survey (2 digits) 

Check that the report contains the correct dates in the flight information report and that the correct 
flight logs are included. 

Lidar Index 
Check the index is present and is named in the correct format and case and dated correctly. 

 Lidar_index_WPNN_YYYYMMDD 

where:  WP is the Work Package name (variable number of characters/digits) 
  YYYY is the year of survey (4 digits) 
  MM is the month of the survey (2 digits) 
  DD is the day of the survey (2 digits) 

Check that it covers the correct area and that the dates in the attribute table match the dates in the 

report, metadata and file names. 
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Appendix A – Workflows in Arc 
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Appendix B – Procedures in Arc 
1. Creating a mosaic from 1k tiles 

Use the search function to find the “Mosaic to New Raster Tool” (or go to Data Management 

Tools>Raster>Raster Dataset> Mosaic To New Raster) 

Select all the 1k rasters, choose and output location and give the output raster a name (use a 

name ≤13 characters and no extension to use the default Arc grid. 

Other parameters to use: 

o Spatial reference = British National Grid 

o Pixel type = 32_BIT_FLOAT 

o Cell size =1 (if data is 1m resolution, otherwise use other value) 

o Number of Bands = 1 

2. Setting symbology 

In the layer properties, go to the symbology tab and choose a colour ramp that will show up 

elevation differences well. Set the stretch type to Percent clip and play around with the values 

of the max percent until you find values that work for the display you’re currently looking at. 

Set the Min value to 0, otherwise the lowest values (the beach) will be coloured the same flat 

colour. You can also change the Statistics dropdown to use “From Current Display Extent” as 

this will stretch the colours of your chosen colour ramp on the part of the dataset that is 

currently visible. If you then also change the Max value of the percent clip to a higher 

percentage, the colours will be pushed into the lower values, giving more elevation detail on 

flat beaches (see example below). When using a higher value for percent clip, spikes are easily 

missed so make sure to change it to lower values when looking for spikes. 
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Percent Clip Min:0, Max: 10, From 

Each Raster Dataset 

  
Percent Clip Min:0, Max: 5, From Current Display 

Extent 

 
Percent Clip Min:0, Max: 20, From 

Current Display Extent 

 
Percent Clip Min:10, Max: 0, From Current 

Display Extent 

 

The Histogram Equalize stretch in combination with the From Current Display Extent statistics 

can also show up features really clearly. 
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Figure B1: Histogram equalize 

 

3. Creating a hillshade from the mosaic 

Use Hillshade (3D Analyst or Spatial Analyst). Use the Elevation raster as the input and choose 

an output folder and name (append _hsh to the raster name) and click OK. 

 
 

Put the Hillshade raster below the mosaic in the table of contents. In the layer properties of 

the Hillshade, go to the symbology tab and change the stretch type to standard deviations and 

click OK. 
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Group the mosaic and hillshade together in the table of contents (select both and right click -

> choose Group), with the mosaic on top. Change the symbology of the mosaic as desired and 

set the transparency to 30%. 
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4. Copying datasets (watermask) 

When copying the watermask for editing, make sure to copy it in the Catalog window (on the 

right of the image below) or through Arc Catalog and then add it to the map. Copying and 

pasting layers in the Table of Contents section of ArcMap (on the left) just duplicates the layer 

but doesn’t create a copy on your drive. Both layers will be pointing to the same dataset on 

the drive. You can check this by looking at the source tab of the layer properties. Likewise 

when you change the name of a layer in the table of contents, it doesn’t change the name of 

the file. You can rename datasets in ArcCatalog or in the Catalog window in ArcMap. 
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5. Create MLWS contours in Arc 

Use the search function to find the “Contour List” tool or go to ‘3D Analyst’ > ‘Raster Surface’ 

> ‘Contour List’ or ‘Spatial Analyst’ > ‘Surface’ > ‘Contour List’. 

Make sure the correct raster is selected as the input surface. Add MLWS levels for all tidal 

stations in the survey polygon as the contour values (click the ‘+’ after every value you type 

in). You can use https://www.tidetimes.org.uk/ to check which tidal stations are available. 

Add a few intermediate values as well if the values are far apart. Save the output somewhere 

in the project folder. 

 
Once the shapefile is created, change the symbology in the layer properties to colour the lines 

by contour value (Use Categories-unique values). 

 

  

https://www.tidetimes.org.uk/
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6. Use Las data in arc and make raster from the intensity values of the points 

The las files are usually organised in polygon folders that match the tide station. To work with 

las files in arcmap, you need to create a las dataset first, then add the las files to the empty 

dataset. Create a las dataset for each flying date in the LAS_Point_Data folder by right-clicking 

the LAS_Point_Data folder in the ArcCatalog window. Select “New” and “Las Dataset”. Name 

the LAS dataset something like this: LSE04_09_20160113.las. 

 

Repeat for each flying date 

 

Right-click one of the new las datasets and click “Properties”. Go to the LAS files tab. Use the 

“Add Files” buttons to add the relevant las files to the dataset (don’t add the files that have a 

“T” in their filename). Go to the statistics tab and click the Calculate Statistics button. On the 

XY Coordinate System tab, pick British National Grid. 

 

Repeat for each flying date 

 

You can now bring in the point clouds in Arc by adding the las dataset to the table of contents. 

You can also load them in ArcScene to look at them in 3D. When bringing the data into Arc, 

open the layer properties and go to the filter tab. Check Last Return to only display the last 

return points. 

 
 

7. Create an intensity raster for each las dataset 

Make an intensity raster for each las dataset with the “Las Dataset to Raster (Conversion)” 

tool (use the Search button to find the tool or go to Conversion Tools>To Raster> LAS Dataset 

to Raster) 

Use the following parameters: 

- Value Field = intensity 

- Cell Assignment = Average 

- Void Fill Method = NONE 

- Output Data Type = Float 

- Sampling Type = Cellsize 
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- Sampling Value = 1.5 (Make sure to change this one! This means the output cells will be 

1.5x1.5m, a bit bigger than the raster to avoid gaps where point density isn’t that high) 

Save the output rasters in the same folder as the las datasets, name them something like 

20151113_Int (no extension, don’t use more than 13 characters). Change the symbology to 

standard deviations between 1.5 and 2.5, you can change it to statistics of current display 

extent as well to make different materials show up better when QC’ing. Very low intensity 

values (black) tend to be water or non-reflective surfaces like roads. 

  

Figure B2: The same intensity raster, on the left with the default 0.5 min and max percent 

clip settings, on the right with a 2.5 standard deviations stretch. 

 

8. Create QC shapefile with dropdown menu for the types of QC issue 

This will create a dropdown menu so the same values won’t have to be typed every time 

- In the root folder, create a new file geodatabase (right-click root folder, select “New” and “File 

Geodatabase”. Name it QC LSE04_09 or something similar 

- Right-click the geodatabase and choose “New” -> “Feature Class”. Give it a name like 

QC_LSE04_09. Leave the type as Polygon features. 

- On the following screen, choose “British National Grid” as the coordinate system 

- On the following 2 screens, keep the default settings 

- On the screen with the field name and data type, Add a field called ErrorType (Data type Text) 

and a field Description (Data Type text). Change the Length of the Description field to 250 

characters:  
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Click “Finish” 

- In the catalog window right-click the new feature class you’ve just created and open the 

Properties. 

- Go to the “Subtypes tab” and Click the “Domains” button at the bottom. 

- In the top table, Type “ErrorType” in the Domain name column, and Error Type in the 

Description column. Under the Domain Properties in the middle, change the Field Type to 

“Text” 

- Fill out the Coded Values table as follows: 

Seaward Limit Seaward Limit 
Polygon Coverage Polygon Coverage 
Water Removal Water Removal 
Gap Gap 
Structures U Structures Unfiltered 
Structures F Structures Filtered 

Spikes Spikes 
Striping Striping 

(When using watermasks, you don’t need the Seaward Limit and Water Removal categories) 
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Click OK 

- Go to the “Fields” tab, Select the Field Name called “ErrorType”. Then click the box next to 

“Domain” under the field properties and select “ErrorType”. 

 
Click OK 

- Add the shapefile to the map, right-click it and choose start editing. Click the create features 

icon on the editing toolbar: 

 
Choose polygon and start creating polygons for each error that you encounter 

Double-click or hit F2 to finish a polygon. 

Open the attribute table and pick the error type for each polygon you create. Add a comment 

in the description field. 

 
Important: on the editing toolbar, frequently click “Editor” > “Save Edits”. 

At the end of the QC session, click “Editor” > “Save Edits” and then “Editor” > “Stop Editing” 
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9. Exporting QC shapefile from geodatabase to shapefile 

Save edits and stop editing. 

Right-click the QC shapefile in the geodatabase, choose “Export” and “To Shapefile (single)…” 

 
Choose an output location (folder) and give the shapefile a name in Output Feature Class box 

+ “.shp” as extension. 

Click OK. 

You can now zip the shapefile (made up of 7 files with the same name) and add it to an email. 

If you don’t zip it, some of the file extensions might be seen as a threat and will be removed 

by some mail servers. 

 

 

10. Edit the watermask 

- Use the “Reshape Features” tool on the editing toolbar :  

- Start and end inside the watermask to extend it: 
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- Start and end outside the watermask to remove parts: 

 
- Don’t forget to save edits 

- Be careful when editing watermasks: it is very easy to accidentally “drag” part of the mask 

slightly. The contractor uses the amended watermask to create the final dataset so if it’s 

“dragged” slightly, the polygon won’t be covered properly. In the image below the black 

outline is the original watermask, the light purple polygon is the edited one and the pale line 

at the top left is the survey polygon. The edited watermask has shifted to the right, while the 

original watermask coincides with the survey polygon boundary on the left. 
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11. Cutting holes in polygons (donut holes) 

- Start editing the polygon. 

- Ensure point snapping is enabled. If it is not, click Point Snapping  on the Snapping toolbar. 

(right-click in the toolbars area and select “Snapping” to display the snapping toolbar). 

- Click the Snapping menu on the Snapping toolbar and click Snap To Sketch. 

- With edit sketch snapping, you can better construct a closed boundary defining the area you 

want to remove. 

- Click the Cut Polygons tool  on the Editor toolbar. 

- Sketch the area you want to remove. Make sure the end vertex snaps to the first one, so you 

end up with a closed polygon. 

- Right-click anywhere on the map and click Finish Sketch. 

- You now have two polygons. Select only the inner polygon and press the DELETE key. 

12. Export index shapefile to Excel spreadsheet 

- Use the “Table To Excel” tool 

- Select the index shapefile as the input 

- Put the output somewhere with all your QC files and give it a name 

 
- Copy the OS_REF column to the QC spreadsheet 

- You can delete the exported excel file now 

13. Drawing quick contours in Arc 

To draw a quick contour at a specified location, use the 3D Analyst toolbar (right-click in the 

toolbar area and add it, if it’s not there). 

 

3D analyst needs to be enabled to use this toolbar. If the buttons are greyed out, Click 

Customize -> Extensions… -> and select 3D analyst. 

In the drop-down menu choose the raster you want to draw contours on, then click the 

contour button to the right of the drop-down menu. If you click somewhere on the raster a 

contour will be drawn following the height of the pixel you clicked. This contour is not stored 

as a shapefile but as a “graphic” and will only go as far as the extent of the window you’re 
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looking at. To select the contour to change the colour or delete it, use the arrow on the 

drawing toolbar, not the arrow from the editor toolbar.  

 

You can change the colour of the new contour by selecting the drawing arrow, right clicking 

the contour, then choosing properties. You can use this feature to find where the land ends 

and the see begins. On land, the contours should be quite long and continuous. You might 

have to click around a bit to find a long contour. On the image below, the black contour is a 

“land” contour, the small blue contours are places where the tool couldn’t find many adjoining 

pixels of the same value. The light coloured contour in the sea is a typical water contour, it is 

an enclosed contour of a very irregular shape. Be aware that it is possible to have enclosed 

contours on land, if there is a mound or a dune or something similar.  

 

When deleting a contour, make sure the Drawing arrow is highlighted, if the editor arrow is 

highlighted and you press delete, one of the features in the shapefile you’re editing could get 

deleted! If this happens, you can use the “undo” button at the top left. If you hover over it 

and it says “Undo Delete Elements” it has deleted the contour graphics which is fine. If it says 

“Undo Delete Features” it has deleted something from a shapefile or feature class. You don’t 

want this to happen unless you want to delete a feature. 
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14. Add profile text files to Arc 

- In ArcMap click, File > Add Data > Add XY Data 

 
- Navigate to the text file, set the X Field to Easting and the Y field to Northing 

- Don’t forget to Edit the Coordinate System to British National Grid 

 
- Click OK 

- In the table of contents, right-click the Events layer and then choose “Data” > “Export Data…” 

- Use the layer’s source coordinate system and choose an output name and location 

- Label the resulting points shapefile with the profile names (Profile or Reg_ID). Use the Labels 

tab in the properties of the points shapefile. 

- Load a shapefile with the profile lines and label them with the profile name 

- Compare the start points and labels and make sure they match 
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15. Convert raster to extent shapefile and check which profile points fall outside the extent 

- Use the reclassify tool to create a constant raster with the exact extent of the final dataset 

- Use the mosaic of the final 1k tiles as the input raster 

- Click the “Classify” button and change the number of classes to 1 

- Save the output raster somewhere and give it a name and Click OK 

 
- Use the Raster to Polygon tool to convert the raster to a polygon 

- Use the constant raster as the input, and choose a folder and name for the output polygon 

- Uncheck the “Simplify polygons” box 

 
- You now have a polygon with the exact same extent as the final raster 

- Go to the “Selection” menu and select “Select By Location…”  

 
- Select features from the points shapefile you created earlier. The source layer is the polygon 

you just created. The selection metod is “are within the source layer feature” 

- Click OK 
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- All points should be selected 

- Verify this by opening the attribute table of the points shapefile and look at the bottom of the 

table. It should say “(XXX out of XXX Selected)” where XXX is the same number 

 
- If it’s not the same number, use the switch selection button at the top. The selection will now 

be flipped 

 
- Then use the “show selected records button at the bottom to only display the selected points 

in the attribute table. These are points that are over areas with noData, or where elevations 

over water have been included 

 
- Take screenshots and make a note of the survey unit, profile, easting and northing and feed 

back to the contractor. 
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Appendix C – QC spreadsheet template 
Lidar_QC_YYYY_YYYY.xlsx where YYYY indicate the winter flying season the surveys were carried out. This spreadsheet should contain one “Master” tab to record checks for 

all delivered work packages and a tab per work package (LSE01_01 for example) that lists every tile in that work package. 

Work Package e.g. LSE04_01 

Polygon Number e.g. P_7055 if subpolygons are being used 

Area e.g. Herne Bay to Dover 

Date of completion of 
Survey 

 

Date received  

Data Quality - Unfiltered Data Checks 

Flight Lines - Optional Check flight line position is appropriate to minimize shadowing 

Point Density - Optional Check point density is appropriate for delivered raster resolution 

Not Integer Check that data is delivered as floating point in metres, not as mm and integers. 

Full Polygon Coverage Check that the raster covers the entire polygon. 

Reach Seaward Limit 

Check that the data reaches the specified seaward limit by using MLWS contours. 
 
If the data fails to reach depth check that flights have been conducted at appropriate times on appropriate tides. If flights were carried out on 
an appropriate tide, make a note in this column that the seaward limit wasn’t reached but that the flight was carried out in an appropriate 
window. 
 
N.B: These contours are not kept after QC is complete, so delete the files when qc is complete. 

Water Removed 
Check that all the water has been removed from the data. It is especially important to check whether rivers, lakes and lagoons have been 
properly removed. Areas with water that are approximately 10m or more in width should be removed.  

No Gaps in Raster 
Check that there are no gaps in the raster where data is missing or has been accidentally filtered out. Use the Las point cloud to check if data 
points are available. Make sure to only use the last return points. If there are no points in a gap, it shouldn’t be flagged. 

Data Spikes 
Check for any spikes in the raster. Make sure that spikes will show up in the symbology settings you’re using for the raster (if the top and 
bottom 5 percent values of the dataset are set to be the same colour, spikes on the lowest beaches and highest cliffs might not be visible.  

Data Stripes/Pocking 

Check for stripes (pocking) in the data. This should be fairly apparent, especially when looking at beach areas. These don’t occur very often. 
They may appear in the data where there have been changes in surface elevation between flight lines within a tidal window – these are within 
system QC tolerances and details of data checks will be provided in the end of project report. Where these are due to calibration error beyond 
the system specification they should be addressed. 

Structures Included Check that fixed structures have not been removed. Floating pontoons, jetties and boats should be removed. 

Date Checked  
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By Initials of who checked the section 

Data Quality - Filtered Data Checks (if applicable) 

Flight Lines - Optional Only fill out if unfiltered data is not delivered.  

Point Density - Optional Only fill out if unfiltered data is not delivered.  

Full Polygon Coverage Only fill out if unfiltered data is not delivered.  

Reach Seaward Limit Only fill out if unfiltered data is not delivered.  

Water Removed Only fill out if unfiltered data is not delivered.  

No Gaps in Raster Only fill out if unfiltered data is not delivered.  

Data Spikes Only fill out if unfiltered data is not delivered.  

Data Stripes / Pocking Only fill out if unfiltered data is not delivered.  

Correct Structures 
Removed 

Check that structures have been removed according to the brief. Beach structures such as groynes, breakwaters and harbour walls might have 
to be included in the filtered data. 

Date Checked  

By Initials of who checked the section 

Initial QC Summary 

Corrections Required? Yes or No 

Corrections Reported 
(Date) 

Date of sending QC shapefile to the contractor 

Corrections received 
(Date) 

Date of receiving corrections from the contractor. 

Comments Any comments on the received corrections. 

Overlapping Polygon Data Checks 

Duplicated Filenames 
with Adjacent Polygons 

Check using the index shapefile that tiles don’t overlap with other polygons. Label the index tiles with their file names. Tiles will be labelled 
twice if there is overlap. If there is an overlap, check that the tiles have different dates. Filenames should not be duplicated! 

Date Checked  

By Initials of who checked the section 

Profile Data Checks (if applicable) 

Lie on correct profile 
lines 

Add the text file to ArcMap using the add xyz data tool. Bring in a shapefile of the profile lines and check that the points from the text file are 
positioned on the profile lines. 

Attributes Check that profiles have 7 columns of data and 1 header row.  

Reach Seaward Limit Check that the profiles reach the required depth by using the ‘Select by Attributes’ tool in ArcMap or by colouring the points by elevation. 
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Extend Seaward to Full 
Extent of Data 

Check that the profiles extend to cover the raster data to its seaward extent. 

Start in correct position Check that the profiles start at the required starting point (same as profiles shapefile or according to other requirements) 

No Data Check that there are no points included where there is no lidar data available. 

Date Checked  

By  

General Checks 

Data Labelling – if 
applicable 

Check that the medium on which the data is delivered is labelled correctly (only for CDs/DVDs) 

Data Filename Make sure the data filenames are be in the correct format and case so that it can be loaded to the website: 

Metadata Check that the metadata form is present and is named in the correct format and case and dated correctly. 

Survey Report Check the survey report is present and is named in the correct format and case and dated correctly.  

Lidar Index 
Check the index is present and is named in the correct format and case and dated correctly. Check that it covers the correct area and that the 
dates in the attribute table match the dates in the report, metadata and file names. 

Survey Polygon 
Check that the correct survey polygon has been delivered. 

Open the polygon in ArcMap and check that it covers the correct area. 

Date Checked  

By Initials of who checked the section 

Unfiltered XYZ Data Checks 

Matching Number of 
Tiles with Unfiltered 
asc Tiles 

Check that the same number of asc and txt files is delivered. This check can only be done after the final data has been delivered. 

Check File Extensions = 
.txt 

Check that the file extension is txt. This check can only be done after the final data has been delivered. 

Date Checked  

By Initials of who checked the section 

Filtered XYZ Data Checks (if applicable) 

Matching Number of 
Tiles with Filtered asc 
Tiles 

Check that the same number of asc and txt files is delivered. This check can only be done after the final data has been delivered. 

Check File Extension = 
.txt 

Check that the file extension is txt. This check can only be done after the final data has been delivered. 
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Date Checked  

By Initials of who checked the section 

QC summary – Final Deliverables 

Corrections Required? Any corrections required on final deliverables? Yes or No 

Corrections Reported 
(Date) 

Date of reporting issues with final deliverables to the contractor. 

Corrections received 
(Date) 

Date of receiving corrections made by contractor. 

Comments Any comments on the received corrections. 

Survey Accepted 

Date  

Name Initials of who checked the section 

Raster Created Create a water-free mosaic raster from the 1k DSM and/or DTM tiles and a hillshade raster for each mosaic. 

Name Initials of who created the raster 

Date  

Loaded to FTP for Website 

Date  

Name  

Comments General comments on encountered issues and relevant feedback from contractor 

Table 1: Master QC worksheet – detailed explanation per column 
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Tile Corr_Req? Gaps Water Removal striping/
pocking 

structures 
(unfiltered) 

structures 
(filtered) 

MLWS 
reached 

polygon 
covered 

seaward 
limit 

spikes Fixed 

SZ2884 
  

x 
   

no 
   

ok 

SZ2984 
  

x 
   

no 
 

x 
 

ok 

SZ2985 no 
     

no 
   

ok 

SZ3084 
 

x x 
   

no 
   

ok 

SZ3085 
  

x 
   

no 
 

x 
 

ok 

SZ3086 no 
     

no 
   

ok 

SZ3184 no 
     

no 
   

ok 

SZ3185 no 
         

ok 

SZ3186 no 
     

no 
   

ok 

SZ3284 no 
     

no 
   

ok 

SZ3285 
    

harbour wall not 
included 

some buildings not 
removed 

no 
 

x 
 

ok 

Table 2: Worksheet to check individual tiles per work package. X’s or comments indicates issue with tile. 
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